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Abstract

The lack of technological knowhow for Computer Graphic Application Soft-
ware is indeed affecting the exploration of the art of Digital painting tech-
nologies among fine art painters in Ghana despite its popularity within the
global fraternity of fine artists. Unlike the traditional painting profession that
requires mainly creative rendering skills to practice, digital painting requires
both computer technological knowhow and creative artefactual rendering
skill to practice. It has therefore been the aim of the author of this paper to
explore the digital technologies in Adobe Photoshop for painting various sty-
listic areas in fine art painting with the same dexterity as practiced in easel
painting to foster popularisation of this art in Ghana. In this practice-led re-
search paper, the focus is on Digital Landscape Painting in Adobe Photoshop.
The descriptive method for documentation of practice-led activities in de-
sign-based research has therefore been adopted to present the outcome of his
research in a detail illustrative procedural format to help inculcate the skills
for colour formulation and compositional rendering skills in digital landscape
painting.

Keywords

Computer Graphic Application Software, Digital Painting Technologies, Digital
Landscape Painting, Colour Formulation, Compositional Rendering Skills

1. Introduction

Since the official introduction of digital painting in 2006 as a course of study in
the Department of Painting and Sculpture at Kwame Nkrumah University of
Science Technology (KNUST), to equip art students with artifactual skills for
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computer artistry, its popularity is yet to gain prominence in Ghana and rub
shoulders with the traditional painting schemes. Efforts at instilling the disci-
pline for digital painting have been relentless. Even though the course is only
taught in first and second year at KNUST, no particular year group of students
have been able to holistically acquire all the relevant skills required for develop-
ing expertise for handling digital painting with dexterity. The theoretical aspect
of the course has been essentially expansive, because the students have to under-
stand the nature of the computer as a system before applying the theory in the
actual artefactual work.

Two years of theory and practical studies is obviously not sufficient to address
all that it takes to be proficient. New media art students therefore complete their
studies, with insufficient expertise for excelling in the field of digital painting
and the purpose of popularising digital painting in Ghana through this study
unfortunately ends up in illusion. It’s on these bases that the author has been
dealing with publications on technological procedures for executing digital
paintings in Adobe Photoshop, focusing on subject matter and stylistic effect to
serve as a manual for both amateur and professional fine art painters to enhance
their digital painting skills, outside the academic environment.

Admittedly, the author’s previous papers on portrait Image Colouration (An-
num & Poku, 2021) as well as Simulation of Impasto Effect in Digital Painting
(Annum, 2022) have been profitable in facilitating New-media artists’ practical
activities in and outside the academic environment. This paper focuses on rudi-
mentary skills for Digital Landscape Painting in Adobe Photoshop version 22
offering procedural description of technological procedures for creating fasci-

nating landscape compositions.

2. Historical Overview of Landscape Painting

Landscape painting is a fine art discipline in which practitioners are mostly in-
spired by the world around them to artistically create natural sceneries that por-
tray compositional elements like mountains, valleys, trees, rivers and forests. It is
not a 21* century art phenomenon. The genesis of this art dates as far back as the
4™ century in China, where Chinese ancient painters sought to capture their im-
pression of the landscape (Konst, 2018).

This art as extensively discussed by Getty (n.d.), was very prominent among
the ancient Greeks and Romans who created wall paintings of landscapes and
gardenscapes until the fall of the Roman Empire when the tradition of depicting
pure landscapes declined, giving way to what was seen only as a setting for reli-
gious and figural scenes. This also continued until the 16" century when artists
began to view the landscape as a subject in its own right. According to Getty, the
artistic shift seems to have corresponded to a growing interest in the natural
world sparked by the Renaissance.

In the 17" century, the classical landscape was born, in which the positioning

of objects was contrived; every tree, rock, or animal was carefully placed to pre-
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sent a harmonious, balanced, and timeless mood. The classical landscape was
perfected by French artists Nicolas Poussin and Claude Lorrain, both of whom
spent most of their careers in Rome drawing inspiration from the Roman coun-
tryside. Italy, at this time, was the preferred location for many artists, who often
travelled there with patrons on the Grand Tour.

In the late 18" century, Pierre-Henri de Valenciennes changed the tide of
landscape painting in France. Valencienne’s groundbreaking book on landscape
painting, “Eléments de Perspective Practique’, published in 1800, which empha-
sized the aesthetic ideal of the “historic landscape,” pushed art Academies in
France to create a prize for this concept in 1817. The next generation of French
landscape painters benefitted greatly from Valenciennes’ efforts. Among them
was Jean-Baptiste-Camille Corot, who was heavily influenced by the historic
landscapes of Valenciennes and by his own travels in Italy.

Getty further hints that the 19" century held many milestones in the history of
landscape art. As the Industrial Revolution altered the traditions of rural life, the
old hierarchy of subjects crumbled. Throughout Europe and North America,
landscape painting gained a new supremacy. Barbizon painters such as Théodore
Rousseau and Charles Daubigny became less concerned with idealized, classical
landscapes and focused more on painting out-of-doors directly from nature. The
19" century also saw the birth of landscape photography, which would greatly
influence the landscape painters’ compositional choices. Revolutionary artists
emerged, such as Gustave Courbet, who pushed the boundaries of landscape
painting even further by making it both a tactile and visual experience. Courbet’s
radical painting techniques and independent spirit paved the way for the next
generation of painters to break from the Academy of the Impressionists.

In the early 20" century, painters continued to embrace the landscape. As
photography gained acceptance as an art form, artists used the medium to create
interpretations of the land through pictorialist effects and, later, through formal
compositions of close-up, cropped views of the landscape. In America, photog-
rapher Ansel Adams captured the country’s attention with his breathtaking
views of the wild beauty of the American West. Even though the major artistic
movements of the mid-20" century were no longer dominated by the landscape as
a subject, the genre’s importance continued as artists responded to fears of in-
creased industrialization, the threat of global destruction, and ecological disasters.

According to Getty, in the second half of the 20™ century, the definition of
landscape was challenged and pressed to include concepts like urban landscapes,
cultural landscapes, industrial landscapes, and landscape architecture. Landscape
photography continued to evolve and rise in popularity. American photogra-
phers like Robert Adams and William A. Garnett used the medium to raise
awareness of conservation concerns. Today, landscape continues to be a subject
artists turn to when contemplating the ways we relate to the places where we live
and the impact of human activities on the environment. This objective, the au-
thor of this paper believes still play dominant role in modern landscape painting
including those done in Digital Technology with software like Adobe Photoshop.
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3. Methodology of the Study

The author’s previous publications (Annum & Poku, 2021; Annum, 2022) have
dealt extensively on the theoretical foundations for employing the Descriptive
Research Method (Alhassan, 2007) to bring clarity to his practice-related re-
search papers. His papers are technological in character, giving procedural ac-
count of steps to follow in executing painting projects using Adobe Photoshop
drawing and painting tools. The appropriateness of this method as a de-
sign-based research tool for imparting practical related knowledge to help in ad-
dressing artistic designing problems in Computerized or Digital art has also been
expatiated upon by (Kennedy-Clark, 2013) and (Anderson & Shattuck, 2012).
Technological skill-based procedures intended to impart artifactual skills for
digital painting should provide instructions, descriptively outlined in a simpli-
fied layout which will be very easy to grasp by all levels of digital art students. It
should indeed offer illustrative demonstration (Teachmint, 2022) of the proce-

dural framework of the designing schemes.

4. Essential Adobe Photoshop Utilities (Adobe Systems,
2013)

The developers of Adobe Photoshop have enhanced the functionality of the
software to enable digital painters to tackle centuries old art subject like land-
scape painting with ease and dexterity.

In earlier versions of Adobe Photoshop, the author had to employ the brush
and the smudge tools to draw and paint various elements in his digital landscape
composition. Although cloud effects were easily rendered from the render sub-
menu under the filter menu, it was very challenging to achieve fascinating trees
and foliage effects using the limited brush tip shapes that offered some vegetative
effects to help in capturing the unique character of foliage in a composition.
However, in most recent versions, specifically 2022 version, schemes for render-
ing variety of trees and foliage have been included to help simplify the task of
generating vegetation for landscape sceneries. This is to complement the essen-
tial utilities of the earlier versions and enhance the artifactual skills of painters
for creative digital landscape painting.

The author’s simplified techniques as expounded in this paper require the use
of the smudge tool, the clone tool, colour adjustment commands, the move tool,

the selection tools, the eraser tool, the gradient tool, filter gallery and the cloud

and foliage rendering tools. The layer palette, colour palette and the brush set-

tings palette are the essentials for the compositional structure and colourization

of the picture elements of trees and foliage.

The Smudge Tool

The smudge tool is the virtual applicator in Photoshop that the author uses to
apply, spread blend and colours as the various elements in the composition are
being manipulated. The tool simulates the action of dragging a finger or a brush

through wet paint. It picks up colour from where the stroke begins and pushes it
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in the direction it is dragged. It is effective for retouching colours or blending
tones of colours in an image. It is customised by using the brush preset picker,
mode, strength and finger painting options.

The brush settings panel defines the character of the tip of the smudge tool.
The harder the brush picker the more distinct the edges of the strokes appear.
The normal smudging mode also creates the best result. The ‘strength’ in this
scheme specifies the volume of paint it drags per stroke of application. The
higher the strength, the more distinct the stroke appears with its colour scheme

and vice versa.
The finger painting option | g7 | in the options bar enables the smudge tool

to apply new colour shades from the colour palette by using the colour shade in
the foreground colour box at the beginning of each stroke. If this is deselected,
the Smudge tool uses the colour under the pointer at the beginning of each
stroke. Holding down the ALT key whilst the smudge is still selected will per-
form the function of applying the current colour displayed in the foreground
colour box. When the ALT key is released, it reverts to the smudging mode. As
the main virtual applicator for blending colours, the smudge tool has to be cus-
tomised to possess the appropriate texture that can smudge to create the desired
effect. The brush tip shape in the brush settings palette provides variety of tex-

tures for this customisation.
The selection of the “sample all layers option” |:§:| in the options bar is

varied in the customisation schemes, relative to what effect is to be achieved with
other layers. When this option is selected, the tool uses colour data from all visi-
ble layers to smudge. If this is deselected, the Smudge tool uses colours from

only the active layer.

The Clone Stamp Tool ’Z‘

The clone stamp tool is used to replicate effects from an image over another
image or part of the same image. To do this, hold down the ALT key whilst you
click a spot on the image. On the clone tool options bar, you can specify a brush
and customize its application effect. You can specify a blending mode, opacity,

and flow. You can also determine how you want to align the sampled pixels with

the “Use same offset for each stroke option” | |'||' | If this option is selected, you

can release the mouse button without losing the current sampling point. As a
result, the sampled pixels are applied continuously, no matter how many times
you stop and resume painting. If you deselect it, the sampled pixels are applied
from the initial sampling point each time you stop and resume painting. You can
also specify which specific layers to sample data from, i.e. either all visible layers
or only from the active layer.

Colour Adjustment Commands (Annum, 2022)

The colour adjustment commands in the adjustment submenu under the im-
age menu (Figure 1), provides commands for adjusting tonal levels of pixels in

images as well as commands for editing colour values in an image. These com-
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mands include Exposure, Vibrance, Colour Balance, Photo Filter, Channel

Mixer, Posterize adjuster, Colour Brightness/Contrast and Hue/Saturation.

Three commands were of significant importance in this practical research.

These were Colour Balance, Hue/Saturation and Colour Brightness/Contrast.

¢ Colour Balance command changes the overall mixture of colours in an image.

¢ Hue/Saturation command adjusts the hue, saturation, and lightness values of
the entire image or individual colour components.

e The Brightness/Contrast adjustment makes simple adjustments to the tonal
range of an image, with the adjustment affecting every pixel in the image. It
does not work with individual channels. The contrast expands or shrinks the
overall range of tonal values in the image.

imagef Layer Type Select Filter 3D View Plugins Window Help
»
= chode e :
Adjustments > Brightness/Contrast...
| Auto Tone shiftrcurleL | Levels. Clrl+L
! Auto Contrast Alt:Shift+Crl+L S Gkl |E
Auto Color Shift+Ctrl+8 ST,
Image Size.. Alt+Clrl+1 Vibrance... )
Canvas Size.. Atteoulse ||| HueSdtiton chifp
g Color Balance... Ctrl+B
Image Rotation » ¢ )
Crop Black & White... Alt+Shift+Ctrl+B
el Photo Flter..
Reveal All Channel Mixer...
Color Lookup...
Duplicate...
Apply Image... Invert ) Ctrl+1
Calculations... B
5 Threshold...
Variables Gradient Map...
Apply Data Set... Selective Color...
Trap... Shadows/Highlights...
Analysis »  HDRToning..
Desaturate Shift+Ctrl+U
Match Color...
Replace Color...
Equalize
Figure 1. Adjustment submenu.
e The Move Tool "I_'
e The author’s compositional techniques require the use of the move tool for

dragging a selected composition element, especially inserted tree or a layer to
a new location in a composition. On the options bar (Figure 2), make sure
“A” (automatically select a group or layer by clicking on a visible pixel op-
tions) and “B” (show transform control on the selected layer) are selected for

effective use of the move tool.

A

B.

rd =

#r ‘%’v\§> tyer ~ I} m &2 E = TWah i e

ot 2, ) o 3 me

Figure 2. Move tool options bar.
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The Selection Tools

Since this practical research is in the category of bitmap imaging which dis-
plays picture elements in pixels, it became necessary to use bitmap selection
tools to isolate one or more parts of an image in order to edit and apply effects
and filters to the selected pixels of the image while leaving the unselected areas
unedited. The lasso tool and the magic wand tool (Figure 3) made it possible to
select picture elements based on the range of colours in a bitmap image. There

are additional commands in the ‘Select menu’ to select, deselect, or reselect all

pixels.
= O Lasso Tool L ‘M Object Selection Tool W
Sﬂ Polygonal Lasso Tool L i"#’ Quick Selection Tool W
Xg/’ Magnetic Lasso Tool L = 7’ Magic Wand Tool W

Figure 3. Selection tools.

The Eraser Tool <2

The eraser tool clears colour pixels in an image as you drag the eraser through
the pixels to reveal elements on an underlying layer or the colour of a back-
ground with a transparency lock. If the eraser is dragged in a background layer
with its transparency unlocked, the eraser clears the pixels to expose the back-
ground transparency. The strength of the eraser to clear pixels is subject to the
increase or decrease of the opacityand flowvalues on the option bar.

The Gradient Tool

The gradient tool is used to create a gradation of tones, shades or gradual
blend between multiple colours. Photoshop provides set of preset gradient fills
for creating these gradations. It however comes with a gradient editor dialog box
(Figure 6) which can be used to define new personalized gradient effects by
modifying any of the preset gradients.

The Filter Gallery

An important functionality in Photoshop that matters most in the simulation
of stylistic effects is the Filter Gallery under the Filter Menu (Figure 4). The Fil-
ter Gallery (Annum, 2022) provides artistic filters that offer the digital artist with
tools for modifying the visual effects of the various elements in a landscape
painting. The artistic category in particular helps in achieving fascinating pain-
terly effects that are not easily realizable with the brush tool. The presence of the
preview window enables the artist to adjust the sliders to desired levels.

Foliage and Cloud Renderer

Adobe Photoshop has simplified a scheme for rendering clouds and foliage in
personalized colour schemes with fascinating effects. These tools can be accessed
from; the Filter menu > Render sub menu. The tree dialogue box for creating va-
riety of foliage has user friendly utilities for personalizing the characteristics of
the foliage and trunk structures. It has two tabs (Basic and Advanced) that dis-

DOI: 10.4236/adr.2024.123013

197 Art and Design Review


https://doi.org/10.4236/adr.2024.123013

G.Y. Annum

play utilities for customising the variety of trees it displays. It also has a preview
window for appreciating the visual effects. You can edit the /ght direction,
amount and size of leaves, the trunk height and thickness. The colours of the
trunk and leaves can also be edited as well as their texture. The shape and char-
acter of the leaves can also be varied. The sliders and the check boxes are the
handlers for customisation. This is what makes Adobe Photoshop the author’s

most preferred software, recommended for amateur digital landscape painting

lessons.

[Filter| 3D Vview Plugins Window Help
Last Filter Alt+Ctrl+F
Convert for Smart Filters
Neural Filters...

Adaptive Wide Angle... Alt+Shift+Ctrl+A
Camera Raw Filter... Shift+Ctrl+A
Lens Correction... Shift+Ctrl+R
Liquify... Shift+Ctrl+X
Vanishing Point... Alt+Ctrl+V
3D »
Blur 4
Blur Gallery >
Distort »
Noise 4
Pixelate 4
Render >
Sharpen 4
Stylize »
Video 4
Other »

Figure 4. Filter gallery.

5. Results and Discussion

The 2022 version of Adobe Photoshop is equipped with digital imaging schemes
to make it possible for any zealous fine artist to create two-dimensional arts in-
cluding Digital Landscape paintings with dexterity. The flexibility of its applica-
tion tools and the millions of colour shades it generates makes it possible for art-
ists to easily create or modify colour schemes and render with fascinating stylis-
tic effects that is not easy to achieve in studio easel painting. The digital proce-
dures discussed below is the result of the author’s familiarity with Adobe Pho-
toshop drawing and painting capabilities as a computer software, as well as his
personal mastery over fundamental artefactual schemes for digital painting with
Photoshop. The procedures are to serve as a fundamental guide to inspire most
especially amateur digital painters in advancing their own techniques for
achieving good results in landscape painting.

Landscape Painting Procedures
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The digital procedures discussed in this paper does not constitute the stan-
dardised blueprint for digital landscape painting, but a basic scheme to offer
guidelines for amateur digital painters in advancing their own techniques for
achieving success in their projects. The flexibility of Adobe Photoshop applica-
tion tools makes it possible to create variety of results even when the procedures
are rigidly replicated.

Step 1: Setting the digital canvas for background and foreground colouration.

For this exercise, a new canvas of size 600 pixels wide by 550 pixels high was
created by using the new document command. The resolution was set to the
lowest of 72 pixels per inch, in RGB colour mode at 8 bit of data per colour
channel. These settings are the author’s scheme for maintaining a freeze-free
working system especially when colour application begins. The purpose for set-
ting any side of the canvas dimension to not more than 600 pixels is to ensure
that any clock speed of computer processor will be able to render colour works

effectively. Figure 5 is the photograph of the landscape scenery for this exercise.

Figure 5. Photographic landscape scenery.

Step 2: Defining the sky and ground areas.

The author’s principal technique is to create a layer for each major element in
his landscape composition so they can be treated independently. In Adobe Pho-
toshop, every new canvas created, is assigned with the name “background” in the
layer palette. The author converts this background into a layer, from which the
sky and ground layers are created.

To do this,

1) Click the padlock on the background and rename layer 0 as “sky”.

2) Right-click on this “sky” layer to display a shortcut menu, and click dupli-

cate layer to create a copy of “sky” layer.
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3) Rename “sky copy” as “ground”. This layer should be on top of the “sky” layer.
4) Open the Gradient Editor to edit a ground effect with two colour stops
(Figure 6). Double click on each colour stop and select an appropriate colour

from the colour picker. Click OK when done and select the linear gradient option

on the options bar.

5) Select the “ground” layer in the layer palette and apply the gradient on the
canvas by clicking and holding down on the mouse button and dragging it ver-
tically across the face of the canvas (Figure 7).

6) Select the lasso tool, and do a freehand drawing of the perimeter of the sky
area on the gradient surface of the ground layer (Figure 8(a)).

7) Select the move tool to display the transform controls (Figure 8(b)), en-
suring that the ground layer is selected in the layer palette.

8) Tap the delete key on the keyboard to delete the selected area. This will re-
veal the blank space of the sky layer under the gradient surface which is the
ground layer (Figure 8(c)).

Gradient Editor

Presets . -,
o
> 3 Basics
Cancel
> 3 Blues
» B3 Purples Import...
> C3 Pinks Export...
? 3 Reds 5
Name:  Custom New

Gradient Type: Solid ~

Smoothness: 100 ~ %

{m

-
L

-
& © O
Stops
Opacity: % Location: % Delete
Color:- - Location: % Delete

Figure 6. The gradient editor.

Figure 7. Applying gradient for ground effect.
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(@ (b) (©)

Figure 8. (a) Drawing with lasso tool; (b) Selection of move tool; (c) Revealing sky area through the ground layer.

Step 3: Rendering of the sky effects.

1) Go to the colour palette and edit the foreground colour box using the col-

our picker to obtain a light blue colour of your choice, living the background
colour box as white (Figure 9).

2) Select the sky layer in the layer palette.

3) Go to filter menu > render > cloud or different cloudto automatically apply
Photoshop cloud effect to the sky layer (Figure 10). By repeatedly tapping the
shortcut, Ctr/ + Alt + F on the keyboard, Photoshop varies the cloud effect for

better option.

Foreground Background ion 5
colour box  colour box s
. Cancel
Add to Swatches
Colpr =
Color Libraries
=
R 164 OH: 206 © (i 82
€ _ 7 s Bl o B
| B: 99 % b: 27
B \ 253 I R: 164 C: 46 %
Only Web Colors. G 214 M: 1 %
B: 253 Y1 %
sEmE ] c°0 ®

Figure 9. Editing of Foreground & Background colour boxes with colour picker

Figure 10. Sky rendering.
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Step 4: Rendering of trees and foliage

The trees and foliage were based on the photographic landscape scenery in
Figure 5 which only served as a guide for the selection of colour schemes. The
author’s digital landscape painting technique starts with the rendering of trees
from the horizon with dark toned colours. It is important to render the trees
movable on the canvas so they can be manipulated independently. This therefore
necessitates the use of separate layers for each major picture element that is to be
introduced in the composition. Ones a picture element is inserted on a separate
layer, it enables you to use the move tool to move it to the appropriate location
in the composition without affecting other picture elements. With the move tool,
picture elements can be scaled to any size, distorted, skewed, rotated or warped
to achieve any desirable effect of interest.

To insert trees and foliage;

1) Select the ground layer and insert a layer above it using the “create a new

layer” command button (Figure 11). This new layer will display a transparent

background.
Layers =
Q Kind . m@THH®
Normal ~ Opacity: 100% -~

lock: B ¢ DN @  Fil: 100% -

Il
© Layer 1
i
© ground
o [Jw
——Cr new layer
N Create a new laye
Create a new layer

Figure 11. Creating a layer for tree rendering.

2) After the layer has been created, go to filter menu > render > tree, to open
the tree dialogue box and customise a tree for the horizon. It is only a matter of
choice to select a tree that fits a composition. The variation is achieved by the
manipulation of the check boxes and the sliders under the Basic and Advanced
tabs. Select the options that can create the best character of foliage. The shrub tree
was the author’s choice in this exercise (Figure 12(a)). After inserting the tree:

a. Use the hard round eraser with 100% opacity and flow to trim the base of
the tree of the foliage (Figure 12(b)).

b. Use a combination of the smudge and clone tools, customized with a suit-
able textured brush tip setting which is close to the texture of the foliage, to paint
the under groove to harmonise the ground colours. The strength of the smudge
tool, as well as the opacity of the clone tool must be adjusted to achieve desired
effect (Figure 12(c)).

3) When this is well done, copies of the shrub can be made by duplicating the
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layer on which the shrub is inserted and relocating with the move tool to fill the
length of the horizon. This will create the thicket (Figure 12(d)). To duplicate a
layer, select the specific layer in the layer palette > layer menu > duplicate layer.
Any additional tree of interest on the ground can also be added from the tree
dialogue box on separate layers. Any other picture element can also be painted
to enhance the creative outlook of the composition (Figure 12(c)). The hue
saturation brightness or the colour balance tool can be used to adjust colour

elements based on their position in the perspective view.

(a) (b)

(c) (d)

Figure 12. (a) Rendered tree; (b) Trimming of shrub base; (c) Texturing the under
groove; (d) Duplication of shrub to create thicket; (e) Adding other picture elements.
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4) One of the challenges in digital landscape painting of trees is about the
painting of specific trees that are not in the collection of what Photoshop pro-
vides. Example is the plantain or banana trees. No sample was found to be close
to this tree. So the ingenuity of the author as a new media artist made the differ-
ence. This handicap necessitated the use of the clone tool to replicate them from
the photographic landscape scenery (Figure 13(a)). It was only to serve as the
preliminary sketch from which painterly effect was to be achieved. The author’s
light cloning technique was employed (Figure 13(b)). The cloning was executed
on a separate layer. This technique requires the opacity of the clone tool to be
adjusted to 35% whilst the Flow remains at 100%. The clone aligned

tool | HIF | has to be selected to ensure that a current sampling point is not lost

when the mouse button is released in the process of cloning.

(a) (b)

Figure 13. (a) Photographic landscape scenery; (b) Light cloning of plantain trees.

5) Ones the light cloning was completed, heightening of the dull colours of the
plantain trees (Figures 14(a)-(c)) was done with the smudge tool figure painting

option| ) |, by which, appropriate colour shades edited in the foreground colour

box were instantly applied. /n any manual tree and foliage painting exercise, it is
Important to set the smudge tool with an appropriate textured tip from the
brush settings panel to help achieve the desire painterly effect. Zooming In and
Out of the image by holding down the ALT key on the keyboard whilst scrolling
the mouse makes it possible to smudge minute areas. It is also important to
regulate the size of the smudge tip in order to fit the structure of the tree and the
foliage for desirable results.

Step 5: Treatment of ground effects

After the smudging of the plantain trees achieved the desired brilliance and
colour saturation, painting of the ground effect (Figure 15) began with the use
of the smudge tool. The swiping motion of the smudge tool was in varied direc-
tion to create accidental strokes. The painting was restricted to the ‘ground’ layer
by selecting it in the layer palette. In this exercise;

a. The choice of the appropriate textured brush tip from the brush preset
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picker as well as the adjustment of the smudge strength to appropriate percentage
level was very vital for achieving the desired accidental effects. The use of the
figure painting option enabled the application of varied colours from the fore-

ground colour box in the colour palette.

(©)

Figure 14. (a) Smudging of the cloned colours; (b) Heightening of plantain tree colours
(stage 1); (c) Heightening of plantain trees colours (final stage).

Figure 15. Painting of ground effect.
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b. The selection of the Sample All Layers option |&.| helped in harmonizing

the ground colours with the under grooves of the shrubs and the plantain trees.

Achieving Creative Painterly Effects

The uniqueness of Adobe Photoshop to create variety of fascinating colour-
istic effect from the same composition makes it the author’s best choice of
graphic application software for digital art. In Photoshop, the colour adjustment
commands in the adjustment submenu under the image menu, provides com-
mands for adjusting tonal levels and chromatic values and saturation strength of
pixels in an image. Two (2) procedures can be adopted to achieve such results.
Either the entire composition of layers is flattened into one (1) layer, from the
layer menu (/ayer menu > flatten image) before the adjustment commands are
used, or all the separate layers in the layer palette are retained whilst they are ed-
ited individually in the composition.

Figure 16(a) shows the effect of using two (2) filters to alter the textural effect of
the ground. These were the ocean ripple under the Distort categories and paint
daubs under the Artistic categories in the filter dialogue box. By randomly adjust-
ing their sliders in the filter dialogue box, interesting accidental effects resulted to
enhance the textural outlook of the ground. This treatment was restricted to the

ground layer, as it was selected in the layer palette before applying the filters.

[ _odl

Figure 16. (a) Finished painting; (b) Altering colour schemes; (c) Altering stylistic effects.
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Figure 16(b) is the result of using Brightness/Contrast, Hue/Saturation and
Colour Balance adjustment commands to work on the composition in Figure
16(a). In this exercise all the layers were retained. The author’s painting technique
that has been discussed in this paper produced five (5) layers of picture ele-
ments; (layer for sky, layer for ground, layer for shrubs, layer for additional trees
and layer for plantain trees). They were individually selected whilst the colour ad-
justment commands were adjusted to obtain the altered result in Figure 16(b).
Figure 16(c) is the result of modifying the visual effects of the various ele-
ments in the composition with selected filters from the filter gallery. At this
stage, all the layers were flattened into a single layer, before the special effects
were applied from filter gallery to modify the creative outlook. The pointillism
finish in Figure 16(c) is the result of random adjustment of the sliders of the

ocean ripple option under the distort category of filter tools.

6. Conclusion

The author’s motivation for conducting this research stems from the difficulties
his New-Media Art students encounter in executing their digital landscape
painting assignments. After introducing them to Adobe Photoshop software and
inspiring them with some collections of professional works, the zealousness and
enthusiasm to excel in performance became evident by their commitment in
class. Unfortunately, the unavailability of manuals to aid them in carrying out
their academic projects in the various aspects of the digital painting discipline
dampened their enthusiasm. This is the principal reason for this documentation
to serve as a manual to foster creative practice among digital artists in art insti-
tutions.

This research work is therefore timely and most appropriate to provide the
necessary rudimentary schemes for equipping both amateur and professional
fine artists with the necessary painting skills for digital landscape painting ex-
ploration. The digital procedures discussed should not be regarded as standard-
ised blueprint for any digital landscape painting project to be executed. It should
be the bases for capacity building that can enhance the creativity of both ama-
teurs and professional fine artists. It is also hoped that this paper will be benefi-
cial to Digital Art Instructors in various art institutions as they offer their stu-
dents with the needed guidelines for creative diversification of approaches in
digital landscape painting in order to overcome prototypical finishes in both

digital and easel painting practice.
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